
POSEIDON  

USER GUIDE 

(v1.7.5) 

Low Poly Water system for Unity 

 

Note: 

Lite version shares the same documentation, with limited features compared to the full product. 

Please see LITE VERSION for more info. 

  



PROLOGUE 

Poseidon is a complete solution for creating beautiful low poly water-scape, especially built for 

Unity developers. This is a must-have asset which saves you thousands hours of work and tons 

of effort, and gives you more time and resources to focus on other aspects of your game. 

This User Guide is created to help you get started with the tool, including the most basic 

information about its features and workflow, as well as best practices, tips and tricks from its 

creator and showcasing amazing work from other successful developers. 

To see the release log, please visit this page. 

For business, please contact: hello@pinwheel.studio 

For support, report a bug or request a feature, please contact: support@pinwheel.studio 

  

http://hello@pinwheel.studio
http://support@pinwheel.studio


RELEASE LOG 

V1.7.3 

IMPROVEMENTS 

- Doubling water mesh bounds for better culling. 

 

=== 

V1.7.2 

IMPROVEMENTS 

- Wave now take account to Water FX. 

FIXES 

- Fix wet lens bug on game start. 

- Fix water planes get rendered in prefab scene. 

- Change Manual Time to double. 

 

=== 

V1.7.1 

IMPROVEMENTS 

- Adding automatic Water Level for WaterFX. 

FIXES 

- Fix GetLocalVertexPosition() bug with Wave Deform parameter (simply set the PerlinNoise.png 

to non-sRGB). 

- Fix WaterFX trigger bug when player stand still but the water raise/lower. 



 

=== 

V1.7.0 

NEW FEATURES 

- Adding support for Aura 2 volumetric light & fog. 

 

=== 

V1.6.3 

NEW FEATURES 

- Adding Wave Mask to define wave height and crest intensity in a particular region. Wave Mask 

take effect on both shader and C# side. 

IMPROVEMENTS 

- Refraction now take Light Absorption into account. Refracted image only visible in range of [0, 

MaxDepth], otherwise it will appear as DepthColor. 

- Caustic now doesn't require Light Absorption anymore. 

FIXES 

- Auto Time mode now take Time.timeScale into account. 

- Minor fixes. 

 

=== 

V1.6.2 

NEW FEATURES 



- Adding Manual Time mode that being set outside of the PWater script. Useful for multiplayer 

games that need to sync water animation across clients. 

FIXES 

- Fix Mesh Noise, Foam, Caustic to use unified Time params. 

 

=== 

V1.6.1 

FIXES 

- Adding simple check for reflection camera rotation to get rid of "Screen position out of view 

frustum..." error. 

- Minor code fix. 

 

=== 

V1.6.0 

IMPORTANT 

- This update requires a complete removal and reimport of the asset! 

NEW FEATURES 

- Complete shader rewrite for both Builtin RP and Universal RP. 

- Adding Flat Lighting option that evaluate lighting uniformly on the polygon. 

- Lambert and Blinn Phong light model now available for Builtin RP. 

IMPROVEMENTS 

- Asset import now a lot faster. 



FIXES 

- Exclude the Water Spline Sync modifier when using Polaris 2019. 

- Minor fixes. 

 

=== 

V1.5.6 

IMPROVEMENTS 

- Adding support for Unity 2020.2 and URP 10.2.2+. 

 

=== 

V1.5.5 

FIXES 

- Skip rendering reflection for Overlay Camera in URP. 

 

=== 

V1.5.4 

NEW FEATURES 

- Adding extension function to query vertex height at runtime. 

IMPROVEMENTS 

- Minor improvements for all shaders. 

FIXES 

- Minor editor fixes. 



 

=== 

V1.5.3 

FIXES 

- Fix shader compile error in URP. 

 

=== 

V1.5.2 

FIXES 

- Fix Water FX setup issue in URP 

 

=== 

V1.5.1 

FIXES 

- Fix build fail issue on Android when Crest Foam is enabled. 

- Fix Ripple and Foam issue on GLES2 and GLES3. 

 

=== 

V1.5.0 

NEW FEATURES 

- Adding Underwater and Wet Lens support for URP. 

- Adding new shader variant for back face render (Tileable Plane only) 



IMPROVEMENTS 

- Adding more instruction to Water FX demo scene. 

FIXES 

- Minor bugs fixing. 

 

=== 

V1.4.1 

IMPROVEMENTS 

- Adding support for Unity 2020. 

FIXES 

- Fix foam issue in URP. 

 

=== 

V1.4.0 

NEW FEATURES 

- Adding Wave effect. 

- Adding Crest Foam and Slope Foam effect. 

IMPROVEMENTS 

- Optimize screen position calculation for URP shader. 

- Adding Height Offset for Polaris Spline Sync modifier. 

FIXES 

- Minor fixes. 



 

=== 

V1.3.4 

IMPROVEMENTS 

- Rewrite URP shaders using newest URP template. Better environment lighting. 

- Water now receive shadow in URP. 

 

=== 

V1.3.3 

NEW FEATURES 

- Adding Tiles Follow Main Camera option for ease of making infinite open water. 

 

=== 

V1.3.2 

NEW FEATURES 

- Adding Water Spline Sync modifier for Polaris Spline tool. 

IMPROVEMENTS 

- Show Foam Color as HDR color picker. 

 

=== 

V1.3.1 

FIXES 



- Fix water mesh type keep revert back to Tileable Plane when entering Play mode. 

 

=== 

V1.3.0 

NEW FEATURES 

- Adding Area, Spline and Custom Mesh mode as experimental features. 

- Adding new River shader for spline mesh. 

IMPROVEMENTS 

- Mesh settings now move from Water Profile to Water component and serialize with the scene. 

- Foam now reacts correctly with scene lighting. 

- Ripple scale well with water object scale. 

- Refine frame pre-render check (depth texture, opaque texture, MSAA). 

- Better tile pinning mode, drag left mouse to add more tiles. 

- Refraction in Builtin RP now uses Grab Texture instead of re-render. 

FIXES 

- Fix gizmos bug in OnSceneGUI callback. 

- Fix Ripple and Foam effect on GLES3. 

 

=== 

V1.2.9 

IMPROVEMENTS 

- Adding support for Refraction and Caustic in VR. 



- Support for Single Pass Instanced stereo rendering. 

FIXES 

- Fix water FX shaders, removing distortion artifacts. 

DEPRECATED 

- Remove support for LWRP. 

 

=== 

V1.2.8 

IMPROVEMENTS 

- Adding some scene view message following mouse position in Tile Pinning mode. 

FIXES 

- Fix some build issues. 

- Unlock water rotation. 

 

=== 

V1.2.7 

FIXES 

- Strip water effect shader to prevent build failure when PPv2 is not installed. 

 

=== 

V1.2.6 

IMPROVEMENTS 



- Stop rendering reflection when not needed. 

FIXES 

- Fix some issues with VR rendering for Light Absorption and Foam. 

- Temporarily disable Reflection, Refraction and Caustic in VR, update coming soon. 

- Minor bug fixes. 

 

=== 

V1.2.5 

IMPORTANT! 

- Please BACK UP your project and perform a clean update due to major package structure 

changes. 

IMPROVEMENTS 

- Re-organize project files. 

- Adding some tests for detecting mis-configuring in package settings. 

 

=== 

V1.2.4 

NEW FEATURES 

- Adding water effect (Underwater, Wet Lens). 

- Adding a back face shader variant. 

IMPROVEMENTS 

- Minor editor workflow updates. 



FIXES 

- Minor issue fixes. 

 

=== 

V1.2.3 

FIXES 

- Fix shader references in LWRP. 

 

=== 

V1.2.2 

NEW FEATURES 

- Now you can select which lighting model to use: Physical Based, Blinn Phong, Lambert. 

IMPROVEMENTS 

- Optimize all shaders for Mobile devices. 

 

=== 

V1.2.1 

IMPROVEMENTS 

- Refraction: now read from camera opaque texture in LWRP, URP instead of re-render the scene. 

FIXES 

- Fix water tiles not being saved in the editor in some cases. 

- Fix material render queue getting resetted to default shader value. 



 

=== 

V1.2.0 

NEW FEATURES 

- Adding more water mesh pattern: Hexagon, Diamond, Quad. 

- New Caustic effect. 

IMPROVEMENTS 

- Better performance for Foam HQ effect. 

- Adding blur filter for Reflection, useful for low-res reflection textures. 

- Reorganize include files. 

FIXES 

- Depth-based effects (Light Absorption, Foam, etc) now work correctly in orthographic mode. 

- Water now reacts correctly to built-in fog. 

CHANGES 

- Ripple effect now always on. 

DEPRECATED 

- Horizon Blend effect was removed. Use built-in fog instead. 

 

V1.1.0 

NEW FEATURES 

- Adding support for Universal Render Pipeline. 

IMPROVEMENTS 



- Editor GUI: Display water tiles list in the inspector. 

FIXES 

- Fix reflection and refraction glitching in LWRP and URP. 

 

=== 

V1.0.1 

FIXES 

- Package now initialize correctly in LWRP. 

 

=== 

V1.0.0 

Initial release 

  



INTRODUCTION 

Poseidon is a user friendly water system dedicated to help you create an impressive water-scape, 

deeply focused on low-poly and stylized world, that can run well on both Mobile and Desktop 

applications, saving you a lot of time and effort! 

Poseidon is carefully designed to totally eliminate the frustration of complexity, giving you the 

fastest and easiest experience of exploring and creating, empowered by the latest techniques 

from the inside, giving the highest quality of achievement. Even if you are a beginner or an 

advanced creator, it is just the right tool for you! 

Different from other low poly water sets, Poseidon is the first one which fully supports Universal 

Render Pipeline and Built-in Render Pipeline, with various settings for you to customize, such as 

light absorption, shore blend, reflection, refraction, etc. Those features can be easily turned on 

and off with a simple toggle. 

Poseidon also comes with sample assets and example scenes for you to play with. You can even 

use them in your commercial projects. Have fun!   



LITE VERSION 

Poseidon Lite is a simplified version provided for someone who wish to have low poly water in 

their game as decoration, without the need of heavy effects or player interaction. 

Below is the list of features that is INCLUDED in the lite version: 

- Builtin RP and Universal RP support. 

- Mesh Type: Tileable Plane. 

- Mesh Pattern: Hexagon, Diamond, Quad. 

- Mesh Noise. 

- Follow Main Camera. 

- Custom queue index. 

- Lighting Model: PBR, Blinn Phong, Lambert. 

- Flat Lighting. 

- Back face rendering. 

- Time mode: Auto. 

- Water color adjustment. 

- Fresnel. 

- Ripple. 

- Light Absorption. 

- Shoreline Foam. 

- Planar Reflection. 

- Refraction. 

Other features, if not mentioned above, is NOT INCLUDED.  



FREQUENTLY USED EDITOR MENUS 

You can easily find Poseidon functionalities in these editor menus: 

- Assets>Create>Poseidon>…: Create specific assets like Water Profile, etc. 

- GameObject>Create>3D Object>Poseidon>...: Create water object in the scene. 

- Window>Poseidon>...: Open additional editor window or configure Poseidon global 

settings.  



CREATE AND CUSTOMIZE WATER OBJECT 

Create Water object 

To create a new Water object, go to GameObject>3D Object>Poseidon>Calm Water [HQ] 

depending on your quality requirement. 

 

A new game object will be spawned into the scene. 

A new Water Profile asset will be created in Assets/ folder. You should rename and store it in a 

different directory for ease of management. 

Select the water game object, in the Inspector, you can see a variety of settings to customize it. 

NOTE: The water object is designed to work without rotation. It is highly recommended to leave 

rotation at (0,0,0) for all features to work correctly, except when you need it for some special 

purposes. 



  



Mesh 

Control water mesh generation. There are 4 mesh types: Tileable Plane, Area, Spline and Custom 

Mesh. 

Tileable Plane 

 

This mode will generate a seamless plane mesh and render it multiple times in different locations 

in the scene to easily cover a large area. 

- Pattern: Chose mesh pattern (Hexagon, Diamond, Quad) 

- Resolution: Resolution of the mesh, higher numbers give more triangles and vertices. This 

will be limited to 100 due to vertices count limit (65k).  

- Noise: Displace vertices on XZ-plane. 

- Tile Size: Width and length of a tile to render in world space. 

- Follow Main Camera: If turned on, the water object will offset itself based on Main Camera 

position. Very useful when you want to make an ocean/open water which only need a few 

pre-pinned tiles. See Creating ocean/open water. 

- Tile Indices: A list of already pinned tiles. Usually you don’t need to modify this list, use 

the “Edit Tiles” button instead. 

To add or remove water tiles, click on Edit Tiles. 



 

Hover your mouse over the scene view, you will see some rectangles. Use Shift+Left Mouse to 

add a tile at that location and Ctrl+Left Mouse to remove one. 

Tip: Instead of clicking, you can drag your mouse to quickly add or remove tiles. 

When you are happy with the tiles, click End Editing Tiles in the Inspector to finish. 

Area (Experimental) 

 

This mode allows you to generate water mesh from concave polygon. The mesh will lay flat on 

XZ-plane at the same Y coordinate of its water object. This is useful for things such as lakes 

and swimming pools where you can strip off unnecessary vertices and save some processing 

power in the vertex shader. 



- Resolution: Resolution of the mesh, higher numbers give more triangles and vertices. This 

will be limited to 100 due to vertices count limit (65k).  

- Noise: Displace vertices on XZ-plane. 

To edit the mesh, click on the Edit Area button. 

 

In the Scene View, use Shift+Left Mouse and Ctrl+Left Mouse to add/remove anchor points. 

Anchor points will be connected to form a concave polygon. At least 3 anchor points are 

required to generate area mesh. Click End Editing Area when done. 

Remember that anchors will be laid on XZ-plane, so switch to Top view for a better sense of 

your area. You can adjust the water object position and scale after this to fit it in your scene. 



 

In this picture, the water object was moved up and scale up a bit to fit in place. 

Spline (Experimental) 

 

This mode allows you to create water meshes that follow a spline to form rivers and streams. The 

flow is not constrained to XZ-plane, but in any direction. Branching is also possible but will need 

some adjustment to hide the intersection. 

- Resolution X/Y: Resolution of each segment mesh. 



- Width: Width of the spline. 

To edit the spline, click on Edit Spline. 

 

- Raycast Layer: Which object layer to perform raycast. 

- Y Offset: Move the newly added anchor along Y axis by this value. 

- Auto Tangent: Smooth the spline when it is modified. 

 



In the Scene View, use Shift+Left Mouse to add anchors. A segment will be created to connect 

the newest and the previous anchor. 

Use Ctrl+Left Mouse on an anchor or segment to remove it. 

Use Left Mouse on an anchor or segment to select it. 

By selecting an anchor, you'll be able to use the builtin transform tool (W-E-R keys) to move, 

rotate or scale it. Its transformation is also shown in  the Inspector. You can’t rotate an anchor 

when Auto Tangent is on. 

 

By selecting a segment, you'll be able to adjust it tangents using the gizmos, when Auto Tangent 

is NOT on. Its properties are also shown in the Inspector. The tiny arrow in the middle of the 

segment indicates its flow path, and will affect Auto Tangent functionality. 

 

- Resolution Multiplier Y: Increase or decrease mesh resolution of a specific segment 

along its path. 

You can add a branch by selecting an anchor, then Shift+Left Mouse on another location. 

Similarly, you can connect 2 anchors manually by selecting an anchor, then Shift+Left Mouse on 

the other anchor. 

NOTE: Anchors and tangents position are in local space. 

Click on End Editing Spline when done. 

You can use the transform gizmos to move, rotate and scale the whole spline at once. 



Custom (Experimental) 

This mode allows you to render the water using custom mesh. Useful when you need the mesh 

to be carefully crafted. However, shader features are quite limited. 

  

- Source Mesh: The mesh to copy data from. Vertex position will be remapped to 0-1 

range, so you need to scale it using the Transform component to fit in the scene. 

- Noise: Adding some random noise to vertex position. 

Rendering 

Contains lighting and rendering settings. 

- Material: The current material used to render water. 

- Queue Index: Render order of the water. 

- Light Model: Select light model, including Physical Based, Blinn Phong and Lambert.  

- Flat Lighting: If turned on, light will be evaluated per-triangle instead of per-pixel, to create 

a crispy polygonal look. 

- Render Back Face: Should it render water when the camera is under water level. Check 

this on when using underwater effect. 



 

Time 

Control the time parameter that used to animate the water. 

- Time Mode: Select Auto to the water will animate itself. Select Manual if you want to set 

its time with custom script, useful when making a multiplayer game where the water 

animation need to be sync across clients. 

- Time: The current time value. To set value for this in Manual mode, use 

ManualTimeSeconds property. 

You can retrieve the current time value by calling water.GetTimeParam(). 

Colors 

Control water color tinting and lighting model. 

- Color: Shallow water color. 

- Depth Color: Deep water color. This requires Light Absorption to be enabled. 

- Specular Color: Specular reflection color. 

- Smoothness: Control the shininess of the water surface. 



Fresnel 

Control the fresnel factor, which is used to blend between reflection and refraction. 

- Strength: Higher value means more reflection, less refraction. 

- Bias: Offset the fresnel value. 

Ripple 

Simulate small movements across the water surface. 

- Height: Height of the ripple. 

- Speed: Speed of the ripple. 

- Scale: Scale of the ripple pattern. 

 

Wave 

Simulate one direction wave effect. 

- Enable: Enable the effect or not. 



- Direction: Movement direction of the waves, in degree. 

- Speed: Movement speed of the waves. 

- Height: Height of the waves. 

- Length: Distance between 2 waves. 

- Steepness: Higher value will push the wave crests forward. 

- Deform: Add some random deformation to the waves. 

- Use Mask: Whether to use Wave Mask texture or not. 

- Visualization: Visualize the mask in the scene view. 

- Bounds: Define the region to apply the Wave Mask texture, in world space. 

- Mask: The mask texture, RG reserved for later use, B is crest intensity, A is wave height.  

 

Light Absorption 

Simulate the effect that objects become darker when light travels through the deep surface of the 

water. 

- Enable: Enable the effect or not. 

- Depth Color: Color of the deep water. 

- Max Depth: The depth where it becomes darkest color. 



Foam 

Simulate foam/shoreline effect where water intersects with other objects, on wave crest or when 

water flow from higher to lower place such as waterfall. 

- Enable: Enable the effect or not. 

- High Quality: Toggle high quality foam mode. 

- Scale/Speed: Define the foam noise. 

- Color: Foam color. 

Shoreline Foam 

- Distance: Distance from the intersection point where foam is visible. 

- Strength: Intensity of shoreline foam. 

Crest Foam 

- Max Depth: Maximum depth of the water body where crest foam is visible. (Crest usually 

appear near the shore, not on deep ocean) 

- Strength: Intensity of crest foam. 

Slope Foam 

- Distance: Distance between 2 foam strips. 

- Flow Speed: How fast the foam move.. 

- Strength: Intensity of slope foam. 



 

Reflection 

Simulate planar reflection effect. 

- Enable: Enable the effect or not. 

- Custom Skybox: Check to reflect custom skybox of the camera (Skybox component). 

- Pixel Light: Should it render reflection texture with pixel light? Turn off to save 

performance. 

- Blur: Adding a slight blur effect to reflection texture, for better quality when using a low 

resolution reflection. 

- Clip Plane Offset: Offset the reflection camera to hide the “gap”. 

- Reflection Layer: Objects in these layers will be reflected. 

- Resolution: Resolution of the reflection texture. 

- Distortion: Adding some distortion to the reflected image. 



 

Refraction 

Simulate refraction effect where light ray gets bent when entering the water volume. 

- Enable: Enable the effect or not. 

- Distortion: Adding some distortion to the refracted image. 



 

Caustic 

Simulate the projection of light rays onto the underwater surface. 

- Enable: Enable the effect or not. 

- Texture: The caustic image. A seamless/tileable one is recommended. 

- Size: Size of the caustic image in world space. 

- Strength: Strength of the effect. 

- Distortion: Add some distortion to the caustic image. 



 

Aura 2 Integration 

This section adds support for Aura 2 volumetric light and fog. 

You need Aura 2 to be imported in your project. Only support Builtin RP (as Aura does). 

- Apply Fog: Apply volumetric fog to the water plane. 

- Apply Lighting: Apply volumetric lighting to the water plane. 

- Lighting Factor: Intensity of the volumetric lighting. 

ADDING WATER EFFECTS 

Water Effect adds underwater fog and lens wetness to your camera. Note that these effects only 

apply in Play mode and built games. 

Water Effect only works for the main camera. 



Installing additional packages 

To use water effects, you have to install the following packages using the Package Manager: 

For Builtin Render Pipeline: 

- Post Processing Stack V2 (com.unity.postprocessing) 

For Universal Render Pipeline: 

- Universal RP (com.unity.render-pipelines.universal) 

Setup for Builtin RP 

After installing the Post Processing Stack V2, select your main camera and add a Post-process 

Layer component: 

 

Then, select a Layer for volume blending. 

Setup for Universal RP 

Select your Universal Render Pipeline Asset, then add a “Water Effect Renderer Feature” to its 

active renderer: 



 

Then, select your Main Camera and set Volume Mask to a desired value. 

 

Add Water Effect component 

To add water effect controller, select the water game object, in the Inspector, under Effect foldout, 

click Add Effects: 

 

A new component will be added to the game object: 



 

Water FX Profile is an asset type containing effect configs to share across your project. You can 

create one by right click on the Project window, go to Create>Poseidon>Water FX Profile. 

Drop your FX Profile into the Profile slot if you already have one, or simply click on New button to 

create a new one.  

You should store the FX Profile in an appropriate directory for reusing later. 

After that, the Inspector should look like this: 



 



Volumes 

Contains configurations for spawning post processing volumes 

- Extent: Define size of the volume box by extent its water bounding box. This value will be 

added to the bounding box size. Too small value will cause glitch or unexpected 

behaviours because the camera goes outside of the volume too soon. Use the Scene view 

to see where your volume will be. 

- Layer: Layer of the volume. Make sure it matches with the Layer value set on your Post-

process Layer or your camera volume mask. 

Underwater 

 

Adding underwater fog, caustic and distortion. 

- Enable: Enable the effect or not. 

Water Body: 

- Max Depth: Maximum depth where it becomes darkest. 

- Surface Color Boost: Increase the intensity of water plane color (backface). 



Fog: 

- Shallow Fog Color: Fog color near the water plane. 

- Deep Color Fog: Fog color when going deeper. 

- View Distance: Maximum distance which object can be seen. 

Caustic: 

- Enable: Enable caustic or not. 

- Texture: Caustic texture. 

- Size: Size of caustic pattern in world space. 

- Strength: Control caustic intensity. 

Distortion: 

- Enable: Enable distortion or not. 

- Normal Map: Distortion texture, where distort vectors are stored in RG channel, which will 

be remapped from [0,1] to [-1,1] in shader code. 

- Strength: How much the object is distorted. 

- Water Flow Speed: How fast the water flows. This will make objects to be distorted faster. 

You can click on Inherit Parameters to fetch value from the Water component. 



Wet Lens 

 

Adding distortion caused by a small droplet on the camera when getting out of water. 

- Enable: Enable the effect or not. 

- Normal Map: Distortion texture, where distort vectors are stored in RG channel, which will 

be remapped from [0,1] to [-1,1] in shader code. 

- Strength: Intensity of the effect. 

- Duration: Fade out duration. 

- Fade: How to fade out over time. 

Events 

Some useful events when getting in or out of water. You can add more stuff such as bubble or 

splash sound here: 

- OnEnterWater: Raise when the main camera get into water (above to below water plane) 

- OnExitWater: Raise when the main camera get out of water (below to above water plane) 

 



 

 

VR CHECKLIST 

Poseidon supports VR, with a reduced features set. Below are details for each render pipeline. 

 Builtin RP Universal RP 

Stereo Render Mode Single Pass Instanced. 

Basic shader features 
(Lighting, color, specular, 
smoothness, etc.) 

Yes Yes 

Fresnel Yes Yes 

Ripple Yes Yes 

Light Absorption Yes Yes 

Foam Yes Yes 

Planar Reflection No No 

Refraction No Yes 

Caustic Yes Yes 

Post Processing 
(Underwater, wet lens, etc.) 

No No 

  



PERFORMANCE TIPS 

Poseidon is highly optimized. However, it’s necessary to achieve higher performance on lower 

end devices. Here are some tip: 

- Disable things you don’t really need. 

- Use URP since these shaders run a bit faster. 

- For Mobile, use simpler light models such as Blinn Phong and Lambert. 

- Lower mesh resolution, vertex animation takes time! 

- Set Mesh Noise to 0 to disable it. 

- Disable High Quality Foam 

- Don’t use Pixel Light for Reflection. 

- Lower reflection & refraction texture size. 

- Filter out objects which will be rendered to reflection texture using Layers. 

- Refraction runs faster in URP since it has downsample options. 

- Increase Tile Size and reduce number of tiles, which will reduce draw calls. 

- Water FX is not suitable for mobile.  



UNIVERSAL RENDER PIPELINE UPGRADE GUIDE 

Poseidon also supports the Unity Universal Render Pipeline. Note that render pipeline other than 

the built-in and URP is not supported. After install and setup URP, the water material will be 

automatically upgraded, if not, disable and then re-enable the Water component. 

Minimum version for URP support: Unity 2019.3 

  



RESOLVING PACKAGE DEPENDENCIES 

Sometimes compilation errors may occur during the development process due to mis-configuring 

package dependencies. There are some ways to resolve them: 

1. “failed to open source file: Packages/com.unity.render-pipelines.universal/…”: This error 

is from URP water shader, install the render pipeline will solve it. You can ignore this error.  

2. “The type PostProcessProfile does not exist”: Usually happens when you uninstall the 

Post Processing Stack V2, or uninstall LWRP/URP. Go to Player Settings, in the Scripting 

Defined Symbol, remove UNITY_POST_PROCESSING_STACK_V2 symbol. 

3. “Namespace UnityEngine.Rendering.LWRP not exist”: Go to 

Window>Poseidon>Project>Update Dependencies to solve this. 

 

  



TUTORIALS 

Creating ocean/open water 

For battleship-like games, it’s not wise to pin a large number of water tiles to create an ocean, 

because each tile is consider as an object to render, thus it will take time to cull and render them. 

Instead, you can use the Follow Main Camera option combine with Unity fog to fake this sense of 

open area. 

1. Set Mesh Type to Tileable Plane. 

2. Set Tile Size to be large enough, 100x100 for example. 

3. Turn on Follow Main Camera. 

4. Click on Edit Tiles. 

5. Hover the mouse in the Scene View, use Shift+Left Mouse to pin some tile around the 

water object position. A grid of 3x3 to 5x5 tiles is enough (that cost 9 to 25 draw call 

already, don’t pin too much). 

6. Open Lighting window and turn on Fog. 

7. Adjust the fog so it can cover the water boundary and blend well with the sky horizon. 

8. Enter Play mode, then try moving the Main Camera to see it work. 

See this video. 

 

https://youtu.be/cOCunWwqIzE
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